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The abundance of inexpensive computers has made it possible to cost
justity learning about computerized accounting concepts using a hands-
on approach to computers. The same abundance of inexpensive
computers has made it possible for many more businesses and govern-
mental agencies to use computers to assist in keeping their accounting
records. Thus, it is even more important that accounting students be
exposed to computerized accounting procedures. The Integrated Ac-
counting software that accompanies this text-workbook enables students
to learn how computers are used in today’s accounting environments.
The ease of running this software removes the technical obstacles of
using the computer so that even the first-time computer user can con-
centrate on the accounting applications.

MAJOR FEATURES

The Integrated Accounting package is composed of a text-workbook
and software disk(s) that provide a realistic approach to computerized,
integrated accounting principles. It consists of three software modules
that contain the major accounting systems commonly found in comput-
erized accounting environments. The first software module contains
integrated accounting capable of handling the processing for businesses
that are organized as sole proprietorships, partnerships, and corpora-
tions; service and merchandising businesses; departmentalized and
non-departmentalized businesses; as well as voucher and non-voucher
systems. The second software module contains complete Fixed Assets
and Payroll systems, and the third module contains a complete per-

[)(‘( ual ill\'(’l]l()l')' sys[cm.

HIGHLIGHTS OF CHANGES
IN THE FIFTH EDITION |

P T R S T T R R

The fifth edition of Integrated Accounting has retained many features
that made the first four editions so successful. Because of technological
changes, industry software innovations, and user feedback from the
previous edition, the following changes have been implemented:

I. Debit and Credit columns have been added to the journal screens,
thereby eliminating the need to enter any negative values.

2. A ratio analysis report has been added to the software.

3. Additional capabilities have been built into the software that allow
it to tailor its processing to a wider array of accounting processing
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tasks (e.g., voucher/non-voucher systems, departmentalized/non-
departmentalized businesses, service/merchandising businesses,
and sole proprietorships/partnerships/corporations).

. Additional print capabilities have been added that enable the user

to direct the displayed report to one of several attached printers, or
to a file on disk for input into a word processor.

. File handling has been enhanced to permit the user to store and

retrieve his/her data to directories (if used) on a wide variety of
different disk drives (e.g., 5 1/4-inch, 3 1/2-inch, hard drives).

6. Input forms have been eliminated from the text-workbook.

7. Separate chapters have been created for partnerships and corpora-

10.

11.

12.

13.

14.

tions to expand coverage of these topics.

. Two spreadsheet chapters have been added that provide basic spread-

sheet operation and enable the user to complete integration appli-
cations with data from the Integrated Accounting software.

- Each new software feature introduced in the text includes “Easy

Steps.” Easy Steps are simple step-by-step instructions for using that
feature. This technique makes the software easy to learn and pro-
vides an easy-to-use reference.

A third computer challenge problem has been added to each chap-
ter (except Chapter 1).

A tutorial problem in each chapter provides all the information
needed to successfully complete the student practice and challenge
problems.

The text has been reorganized in such a way that students are ex-
posed to many types of ongoing accounting systems, covering a wide
variety of accounting processing. Thus, the user becomes very fa-
miliar with the software and its features before he or she is expected
to set up a new computerized accounting system (Chapter 12).

Student check figures for each of the end-of-chapter computer prob-
lems have been provided in the instructor’s manual.

The Inspector software for checking student’s data files has several
enhancements, such as non-case sensitive checking.

ORGANIZATIONAL FEATURES

The text-workbook consists of fourteen chapters and two comprehen-
sive problems. Each chapter contains concise explanations of the material
presented with sample illustrations, screen displays, computer-gener-
ated output, a tutorial problem, a student exercise, a practice problem,
and a student challenge problem. In addition, fundamental data pro-
cessing terms are defined in the context in which they are used
throughout the text.



Preface Integrated Accounting for DOS

LEARNING OBJECTIVES

This courseware package is intended for students who want to learn
about computerized accounting principles. Therefore, the major objec-
tive of this book and its associated computer software are (1) to present
and integrate accounting principles in such a way that no prior knowl-
edge of computer or computerized accounting is required and (2) to
provide a hands-on approach to learning how modern computerized
integrated accounting systems function. Each chapter identifies the
learning objectives that are to be mastered. These objectives correspond
to the sequence of options designed into the accompanying software.

Additional flexibility has been designed into the computer software
to permit its use with most traditional accounting textbooks. The com-
puter may be used to solve many of the manual accounting problems in
these textbooks. Thus, the application of the software is limited only by
the students’ imagination and desire to learn.

MESSAGE TO THE INSTRUCTOR

This package has been designed so that the material and the computer
exercises presented in this text-workbook can be introduced gradually
through the use of beginning data files that permit the processing of
ongoing accounting systems. In this way, students can concentrate on
learning accounting topics while they gain experience with the various
features of the software.

Each chapter contains a tutorial problem to help students learn the
important operational characteristics of the software quickly. Each chap-
ter also contains a student exercise, a student practice problem, a student
challenge problem, and audit tests to ensure that students comprehend
the material presented. This approach permits students to work inde-
pendently and at their own rates.

An instructor’s manual is provided to assist you while using Inte-
grated Accounting. In addition, a solutions checker disk called the
Inspector Disk is available to electronically check your students’ solu-
tions against the solutions provided on the Inspector Disk. The solution
files provided on the Inspector Disk represent the same solutions pro-
vided in print in the instructor’s manual. Also, student check figures
for each of the end-of-chapter computer problems are provided for use
at your discretion.

MESSAGE TO THE STUDENT

The Integrated Accounting software is designed so that computer-
generated output, the integration processes, and the accounting proce-
dures are very similar to those currently used in business and industry,
whether the business systems use large or small computer systems. The
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significant difference between the software used in this package and an
actual business system is the simplicity of computer operation.

When a business or industry uses a computerized system to control
such valuable assets as cash and accounts receivable, very tight controls
arc maintained on security, data entry, and audit trail procedures. These
controls often complicate the operation of a computerized system. Some
of these restrictions have been intentionally omitted from this package
in the interest of simplifying the operations and providing a usable,
relevant educational tool.
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LEARNING

INTRODUCTION

This text will teach you about computerized accounting using a hands-
on approach. You will learn to operate the software by entering realistic
accounting transactions for a variety of business applications and by
generating financial statements as well as other management informa-
tion reports.

The software makes use of a standard user interface that utilizes
pull-down menus, movable overlapping windows, mouse support, list
windows, and help windows. This standard interface is similar to the
interface used in many other software applications. Most of the tech-
niques you learn in this book can be applied to many other software
packages. This will make the transition to other applications very easy.

The Integrated Accounting Software

The Integrated Accounting software consists of three modules with the
opening balance data and template files all on one 3 1/2-inch disk.
Module 1, named IAl, contains the integrated accounting software for
general ledger, accounts payable, accounts receivable, and financial state-
ment analysis. Module 2, named IA2, contains the software for fixed
assets and payroll. Module 3, named IA3, contains the inventory soft-
ware.

The data files contain the opening (or beginning) balances for each
problem in the textbook. Therefore, before a problem can be solved,
the beginning data must be loaded. On a hard disk or network system,
the data and template files should be copied into the same directory as
the software.
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This Text-Workbook

Each chapter begins with an introduction that describes the topics to
be covered. The introduction is followed by the operating procedures
required to enter and process the data presented in the chapter. At the
end of each chapter is a tutorial problem (identified as problem A) with
detailed operating instructions. If you have difficulty with an activity in
the tutorial problem, refer back to the operational procedure that de-
scribes the activity. Page references are provided for each step of the
tutorial problem. Following the tutorial problem is a student exercise,
a computer practice problem B, and a computer challenge problem C.

This book uses features that will make learning the Integrated Ac-
counting software easier and allow you to locate reference information
quickly and easily. These features are listed below.

1. Each pull-down menu is shown in the chapter.

2. Each data entry window is pictured with an explanation of each of
the data fields.

3. Throughout the text, useful illustrations and notes are provided in
the margins.

4. An illustration showing a partially completed input form is pro-
vided for many data entry screens.

5. Brief step-by-step procedures called Easy Steps are provided for each
computer activity (such as menus, data entry, and report printing).
The Easy Steps make the activities easier to learn and serve as a
reference when you are working the end-of-chapter problems.

OPERATING PROCEDURES

The operating procedures in this chapter include pull-down menus,
mouse instructions, data entry windows, list windows, dialog windows,
and report windows. In addition, the operating procedures for start-
up, the File menu, the General Information data entry window, setting
the display type, setting the colors, and using the Help menu will also
be covered.

Using a Mouse

The Integrated Accounting software works with a mouse. If you have a
mouse connected to your computer, the pointer will be displayed on
your screen as a small rectangle (). The pointer moves on the screen
as you move the mouse. The following functions can be performed
with a mouse:

Point Move the pointer to a specific location on the screen.
Click Quickly press and release the left mouse button.
Drag Press and hold down the left mouse button and move

the mouse.

Chapter 1
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Point and click Pointing to an object on the screen and clicking the
mouse button is “clicking on the object.” For example,
if you are directed to “click on” the Ok button, you
should point to the Ok button and click the left mouse
button.

One of the ways you can communicate with the computer is with a
menu. A menu contains a list of commands. Figure 1.1 shows the parts
of the Integrated Accounting menu system.

Menu Name Menu Bar

Figure 1.1
Pull-Down Menus

Menu Command /

Pull-Down Menu ‘

Quick Keys

Hot Key
Menu Bar. The menu bar is the top line of the screen, which shows the
menus that are available. The menu bar is different for the Accounting
System, Fixed Assets, Payroll, and Inventory software systems.
Menu Name. Each of the words on the menu bar is the name of one
of the pull-down menus. If a menu name is “dimmed,” it is not avail-
able.
Pull-Down Menu. A pull-down menu is a list of commands that ap-
pears immediately below the selected menu.
Menu Command. The menu commands are the menu items, such as
New and Open Accounting File shown in the File menu in Figure 1.1.
They are referred to as commands because they command the com-
puter to perform a particular action.
Quick Key. Each menu name and each menu command has a quick
key associated with it. The quick keys appear on the screen as either a
bright or an underlined letter (within the menu or command name).
Quick keys allow easy menu or menu command selection.
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Hot Key. Some menu options can be selected without pulling down a
menu by using a function key or a key sequence. For example, pressing
the F9 function key while a report is displayed will cause the computer
to print the displayed report to an attached printer. If a menu com-
mand has a hot key, it will be shown on the pull-down menu.

Table 1.1 describes keyboard keys that you will find useful when
working with pull-down menus.

Key Function

Alt Use this key to transfer control to the menu bar to
select a pull-down menu.

Esc Use this key to release control from the menu bar or
to remove any pull-down menu.

Use this key to pull down a menu. Each time this key
is pressed while a menu is pulled down, the highlight
bar will move down to the next menu command. If
the highlight bar is on the last command, it will wrap
around to the first command.
‘ the highlight bar up to the

Down Arrow

Selecting and Choosing
Menus and Menu Commands

With the Integrated Accounting software, the terms select and choose
have different meanings. When menus on the menu bar or menu com-
mands are selected, they are highlighted. When a highlighted (or selected)
menu or command is chosen, the software will take the appropriate ac-
tion. Dimmed commands are not available at the current time (you may
need to select another command before using a dimmed command).

Pulling Down a Menu and
Choosing a Menu Command

Keyboard

1. Press the Alt key.
When the Alt key is pressed, the first menu on the menu bar (File)
is selected.

2. Press the Left or Right Arrow key to select a menu.
As you move through the menus with the Left and Right Arrow
keys, any menus that are inactive (dimmed) are skipped.

Chapter 1 5

Table 1.1

Keys Used with Pull-Down
Menus

If the menu command has a
highlighted or underlined
letter, you can choose a
menu command by typing
the letter that is highlighted
or underlined. For example,
to choose Open Accounting
File, type O. As we have
noted, these highlighted
letters are called “quick
keys” because they allow
you to select menu com-
mands quickly using the
keyboard.
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Figure 1.2
File Menu

3. Press Enter to choose the selected menu.
The chosen menu will appear with the first menu command high-
lighted. For example, if the File menu is chosen, the screen will
appear as shown in Figure 1.2. If the name in the menu bar has a
highlighted or underlined letter, you can press Alt to select the menu
bar, and then type the letter that is highlighted or underlined. For
example, to pull down the Help menu, press Alt, then H.

4. Use the Up and Down Arrow keys to select the menu command,
then press Enter to choose the command.

Mouse

1. Pull down the menu by pointing to the name of the menu on the
menu bar and clicking the left mouse button.

2. Point to the menu command and click the left mouse button.
To move directly to a menu item, point to the menu name and drag
the hig\hlight bar down the menu until the menu command is high-
lighted, and then release the mouse button.

Windows

You interact with the computer to perform the integrated accounting
procedures through windows. A window is a rectangular area of the
screen in which the software is communicating with the user. Often the
screen contains only one window. At times, two or more overlapping
windows may appear on the screen. However, only one window is active
at a time. The Integrated Accounting software uses four different types
of windows: data entry, list, dialog, and report windows.

To use the software, it is helpful to understand how to work with each of
these four types of windows. The following paragraphs describe how to use
these windows with a mouse and the keyboard or with the keyboard alone.

Data Entry Windows

Data is keyed into the computer from the computer’s keyboard and
displayed in data entry windows as it is keyed. This process is called
data entry. Figure 1.3 shows the parts of a data entry window.



